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Analiza audytywno-akustyczna danych językowych 
z wykorzystaniem programów komputerowych: 

EXMARaLDA i Praat

Auditiv-akustische Analyse linguistischer Daten mit Hilfe von Computerprogrammen: 
EXMARaLDA und Praat

    Im vorliegenden Beitrag sollen ausgewählte Funktionen von zwei Computerprogrammen vorgestellt 
werden, mit denen auditiv-akustische Analysen von Sprachdaten durchgeführt werden können: EXMA-
RaLDA und Praat. Je nach Forschungsinteresse und Genauigkeitsgrad der linguistischen Beschreibung 
(von der Erfassung des Wortlauts der Äußerungen über die zusätzliche Beschreibung suprasegmentaler 
und prosodischer Phänomene bis hin zur phonetischen Analyse) ermöglichen diese Programme Tran-
skription, Annotation und Sprachanalyse. Aufgrund ihrer Funktionalität können sie sowohl einzeln als 
technische Unterstützung für   vertieft e auditive (v. a. EXMARaLDA) oder akustische (v. a. Praat) Analysen 
als auch gemeinsam zur Visualisierung oder Objektivierung von Höreindrücken eingesetzt werden. EX-
MARaLDA eignet sich besonders für die Sprachanalyse, da es in der Lage ist, den Klang auch sehr langer 
Äußerungen zu erhalten und aufzuzeichnen, ausgewählte Phänomene zu selektieren sowie Textkorpora 
zu erstellen und zu verwalten. Für die akustische Analyse ermöglicht Praat eine detaillierte Analyse der 
physikalischen Eigenschaft en von Sprache, einschließlich Grundfrequenzanalyse, Schallintensitätsanaly-
se, Spektralanalyse, Formantenanalyse oder Analyse der Stimmqualität.   Je nach Forschungsgegenstand 
können die beiden Methoden (Analyse der Höreindrücke und Analyse der physikalischen Eigenschaft en 
der Sprache) unabhängig voneinander oder parallel eingesetzt werden. Das so gewonnene Forschungsma-
terial kann zu einer vertieft en Analyse sprachlicher Daten beitragen und fi ndet nicht nur in der Sprach- 
und Kommunikationsforschung im weitesten Sinne Anwendung, sondern auch in der interdisziplinären 
Forschung, die verschiedene Disziplinen und Forschungsansätze miteinander verbindet. Der Beitrag ist 
praxisorientiert und soll Interessierte mit ausgewählten Funktionen zur qualitativen und quantitativen 
Analyse von (Signal-)Sprache vertraut machen.
Schlü sselwö rter: EXMARaLDA, Praat, auditiv-akustische Analyse

Auditory-Acoustic Analysis of Linguistic Data Using Computer Programs: 
EXMARaLDA and Praat

Th e purpose of this article is to present selected features of two computer programs that can be used to 
perform auditory-acoustic analysis of linguistic data: EXMARaLDA and Praat. Depending on the research 
interests and the degree of precision of the linguistic description (from recording the wording of the utter-
ances to the additional description of suprasegmental and prosodic phenomena and phonetic analysis), 
these programs allow the transcription, annotation and analysis of speech. Due to their functionality, they 
can be used separately, providing technical support for in-depth auditory (mainly EXMARaLDA) or acous-
tic (mainly Praat) analysis, or together, allowing visualisation or objectifi cation of auditory impressions. 
EXMARaLDA is particularly suitable for speech analysis, as it can preserve and transcribe the sound of 
very long utterances, select specifi c phenomena, and create and manage text corpora. For acoustic analy-
sis, Praat allows detailed analysis of the physical properties of speech, including fundamental frequency 
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analysis, sound intensity analysis, spectral analysis, formant analysis or voice quality analysis. Depending 
on the research question, the two methods (analysis of auditory impressions and analysis of the physical 
properties of speech) can be used independently or in parallel. Th e research material obtained in this way 
can contribute to in-depth analysis of linguistic data and is used not only in speech and communication 
research in the broadest sense, but also in interdisciplinary research combining diff erent disciplines and 
research approaches. Th e article is of a practical nature and aims to familiarise the interested reader with 
selected functions for qualitative and quantitative analysis of (signal) speech.
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1. Wprowadzenie

Celem artykułu jest przedstawienie wybranych funkcji dwóch programów kompute-
rowych dla (nie tylko) lingwistów, za pomocą których można przeprowadzać anali-
zy audytywno-akustyczne danych językowych. Mowa o programach EXMARaLDA 
(Schmidt/Wörner 2014) i Praat (Boersma/Weenink 2024), które w zależności od za-
interesowań badawczych i stopnia precyzji opisu językowego (od analizy całych zda-
rzeń komunikacyjnych w postaci transkrypcji opartej na ortografi i przez dodatkowy 
opis zjawisk suprasegmentalnych i prozodycznych aż do specjalistycznej analizy fo-
netycznej) umożliwiają transkrypcję, anotację i analizę mowy.1 Ze względu na swoją 
funkcjonalność oba programy mogą być wykorzystywane osobno, stanowiąc wsparcie 
techniczne dla pogłębionych analiz audytywnych (głównie EXMARaLDA) lub aku-
stycznych (głównie Praat), albo razem, umożliwiając wizualizację tudzież obiektywi-
zację wrażeń słuchowych. Teksty mówione można badać bowiem w dwojaki sposób: 
na podstawie subiektywnej oceny słyszanej mowy i/lub na podstawie obiektywnych 
właściwości fi zycznych dźwięku. Specyfi ka ustnej odmiany komunikacji (osadzenie 
w konkretnej sytuacji komunikacyjnej, indywidualne cechy mówców, multimodalność 
przekazu ustnego, spontaniczność i ulotność mowy, zewnętrzne bariery komunika-
cyjne) sprawia, że podstawową metodą badawczą są dla niej badania percepcyjne.2 
Niemniej (dodatkowa) metoda pomiarowa cech fonetycznych, takich jak np. zmiany 
w obrębie częstotliwości podstawowej czy intensywności głosu, pozwala zaobserwować, 
za pomocą jakich środków parajęzykowych osoba mówiąca kształtuje swoją wypo-
wiedź. Uzyskane w ten sposób dane umożliwiają obiektywizację wyciąganych póź-
niej wniosków. Niniejszy artykuł powstał w wyniku doświadczeń zdobytych podczas 
prac zapoczątkowanych w niemiecko-brytyjsko-polskim projekcie badawczym Ge-
Wiss (Badanie porównawcze wypowiedzi naukowych. Język niemiecki w porównaniu 

 1 Poza tytułowymi istnieją również inne programy do analizy mowy. Więcej na temat dostęp-
nych narzędzi patrz Pieniowska (2019).

 2 Więcej na temat analizy audytywnej w badaniach językoznawczych patrz Grzeszczakowska-
-Pawlikowska (2010).



Analiza audytywno-akustyczna danych językowych … 449

z językami angielskim i polskim).3 Artykuł ma charakter praktyczny i ma na celu za-
poznanie zainteresowanych osób z wybranymi funkcjami służącymi do jakościowej 
i ilościowej analizy (sygnału) mowy. Ścieżki dostępu do funkcji omawianych w artykule 
znajdują się w załączniku.

2. EXMARaLDA

Program EXMARaLDA został stworzony na Uniwersytecie w Hamburgu przez 
Th omasa Schmidta i Kaia Wörnera. Jest to system operacyjny umożliwiający two-
rzenie korpusów tekstów mówionych, który składa się z trzech części: narzędzia 
do transkrypcji i anotacji tekstów (Partitur Editor), narzędzia do zarządzania me-
tadanymi i korpusami (Corpus Manager) oraz narzędzia do wyszukiwania i analiz 
wybranych zjawisk językowych (EXAKT). Podstawowym narzędziem do obróbki 
plików (audio lub wideo) jest Partitur Editor, który automatycznie scala wybraną 
ścieżkę dźwiękową z oscylogramem, co pozwala na dokładny zapis mowy w for-
mie, która może przywodzić na myśl partyturę muzyczną (w tym zapis mowy sy-
multanicznej, pauz pustych i wypełnionych oraz elementów niewerbalnych). 

Grafi ka 1. Widok okna Partitur Editor z widocznym oscylogramem i zaznaczoną na nim 
pauzą pustą oraz znajdującymi się pod nim liniami transkrypcyjnymi

W zależności od liczby osób biorących udział w komunikacji (monolog, dialog, polilog) 
system umożliwia tworzenie różnego rodzaju linii transkrypcyjnych: linii werbalnych 
dla mówców, w których zapisywane jest dokładne brzmienie wypowiedzi (linie [v]); linii 
z komentarzami, w których transkrybenci mogą zapisywać uwagi do danej wypowiedzi 

 3 W ramach projektu GeWiss (niem. Gesprochene Wissenschaft ssprache kontrastiv) nagrano, 
a następnie przetranskrybowano w programie EXMARaLDA referaty studenckie, referaty 
eksperckie i rozmowy egzaminacyjne. Więcej na temat projektu GeWiss patrz https://gewiss.
uni-leipzig.de/.
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i do okoliczności jej towarzyszących (linie [k]) oraz linii nieprzyporządkowanych do kon-
kretnego mówcy (linie [nn])4, w których zapisywane są np. słyszalne w nagraniu zjawiska 
zewnętrzne mające bezpośredni wpływ na przebieg komunikacji, w tym na jej ewentualne 
zakłócenia, np. sygnał przejeżdżającej karetki. W poniższej grafi ce (grafi ka 1) przedstawio-
no przykładowy widok okna Partitur Editor, na które składa się oscylogram z zaznaczoną 
pauzą pustą (0.7) oraz linie transkrypcyjne.

Prezentowane w artykule fragmenty wypowiedzi pochodzą z ok. 24-minutowej roz-
mowy egzaminacyjnej z zakresu dydaktyki języka polskiego jako obcego, jaka została 
przeprowadzona na jednej z polskich uczelni wyższych i nagrana w ramach projektu Ge-
Wiss. Uczestniczkami rozmowy są trzy egzaminatorki (AD_1489, AB_1490, UD_1491) 
i studentka (MK_1486). Cały egzamin został przetranskrybowany zgodnie z konwen-
cjami transkrypcyjnymi typu GAT 2 dla tzw. transkrypcji minimalnej (por. Selting et al. 
2009), według której w linii werbalnej poza dokładnym brzmieniem wypowiedzi reje-
strowane są również: pauzy puste, które są automatycznie mierzone, a następnie zapisy-
wane w pojedynczym nawiasie; pauzy wypełnione (yyy); sygnały recepcyjne (mhm, hm, 
hm_hm) oraz zdarzenia niewerbalne zapisywane w podwójnym nawiasie, np. ((śmiech)).5 

Aby przygotować nagranie do transkrypcji, w pierwszej kolejności należy załączyć wy-
brany plik dźwiękowy (funkcja „Recordings”), a następnie wprowadzić mówców (funkcja 
„Speakertable”) i wyznaczyć dla nich odpowiednie linie (funkcja „Tier”), patrz grafi ka 2. 

Grafi ka 2. Widok okna Partitur Editor z wprowadzonym plikiem dźwiękowym 
i przygotowanymi liniami transkrypcyjnymi

Po wprowadzeniu niezbędnych danych można wydzielić pierwszy segment trans-
krypcji. Służyć do tego będzie funkcja „Append interval”, która znajduje się między 

 4 Skrót od ang. no name (‘bez nazwy’). 
 5 Na potrzeby projektu GeWiss konwencje transkrypcyjne GAT 2 zostały dostosowane do 

wielojęzycznych danych, w tym do języka polskiego. Więcej na ten temat patrz Rogoziński/
Zarzeczny (2012) oraz Lange/Slavcheva/Rogozińska/Morton (2014).
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oscylogramem a liniami mówców. Kliknięcie na nią powoduje, że program automatycz-
nie wydziela dwusekundowe interwały, które można dowolnie (manualnie za pomocą 
kursora) skracać lub wydłużać, tworząc w ten sposób granicę początkową (linia zielona) 
i końcową (linia czerwona) analizowanego segmentu, patrz grafi ka 3. 

Grafi ka 3. Widok okna Partitur Editor z automatycznie wydzielonym, 
dwusekundowym segmentem

Do tak przygotowanego segmentu można wprowadzić fragment transkrypcji i dowol-
nie go edytować, nawet na dalszych etapach prac.6 Podstawowa zasada transkrybowania 
polega na tym, by zapisywać wszystko, co słyszymy, w tym pauzy (puste i wypełnione), 
które mogą pełnić nie tylko funkcje strukturyzujące wypowiedź, lecz przede wszyst-
kim funkcje komunikacyjne i retoryczne. Jak pokazano wyżej, pauzy puste zapisywane 
są w osobnych segmentach (po uprzednim, ręcznym wyznaczeniu ich granic), a ich 
dokładny czas trwania jest odczytywany w oknie znajdującym się nad oscylogramem 
(por. grafi ka 1).7 Opracowany segment należy każdorazowo zapisać, klikając na opcję 
„Enter” – kontynuując w ten sposób wyznaczanie i zapisywanie kolejnych segmentów. 
Każdy segment powinien kończyć się spacją, aby zachować w transkrypcji niezbędny 
odstęp między wyrazami/znakami transkrypcyjnymi znajdującymi się na końcu i na 
początku sąsiadujących z sobą segmentów. Na każdym etapie procesu transkrypcyjne-
go możliwe jest uszczegółowienie zapisu. Konwencje GAT 2 umożliwiają transkryp-
cję trzypoziomową: minimalną (niem. Minimaltranskript), w której zapisywane jest 

 6 Należy jednak przy tym pamiętać, że niemożliwe będzie późniejsze edytowanie samych granic 
danego segmentu. Końcowa granica każdego wyznaczonego przez osobę transkrybującą seg-
mentu staje się jednocześnie granicą początkową segmentu kolejnego, dlatego raz wyznaczone 
granice (segmentów) nie mogą być zmieniane na dalszych etapach prac transkrypcyjnych.

 7 Według konwencji GAT 2 w osobnym segmencie zapisujemy tylko pauzy dłuższe niż 0.2 
sekundy, zaokrąglając je do jednego miejsca po kropce. Krótsze pauzy (tzw. mikropauzy) 
zapisywane są za pomocą kropki w nawiasie pojedynczym, por. zestawienie znaków trans-
krypcyjnych w załączniku.
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brzmienie wypowiedzi, bazową (niem. Basistranskript), która jest uzupełniana o wy-
brane informacje prozodyczne i dokładną (niem. Feintranskript), która umożliwia 
jeszcze precyzyjniejszy opis zjawisk suprasegmentalnych i prozodycznych, takich jak 
np. akcent wyrazowy, akcent fokusowy, zmiany wysokości tonu, głośności czy tempa 
mówienia. EXMARaLDA wprawdzie nie oferuje analizy stricte akustycznej związanej 
z pomiarem właściwości dźwięku (do tego celu używany jest Praat; patrz punkt 3), 
lecz wspomaga percepcję i ocenę realizacji tych segmentów wypowiedzi, które zna-
cząco różnią się od pozostałych. Przyczynia się do tego oscylogram, który przedstawia 
przebieg zmian fali dźwiękowej i długości pauz, ułatwiając w ten sposób interpretację 
zjawisk językowych. Po zakończonej transkrypcji i anotacji tekstu program za pomocą 
narzędzia EXAKT oferuje wyszukiwanie wybranych zjawisk w ich lewym i prawym 
kontekście oraz automatyczne lub ręczne fi ltrowanie i sortowanie wyników zapytań 
oraz eksportowanie ich do innych aplikacji, w tym też do Praata, patrz grafi ka 4.

Grafi ka 4. Widok okna EXAKT ukazujący wyniki wyszukiwania pauz wypełnionych (yyy) 
wraz z ich lewym i prawym kontekstem oraz informacją o mówcach

3. Praat

W badaniach nad mową ważna jest nie tylko analiza środków językowych (fonetycznych, 
morfologicznych, leksykalnych składniowych, pragmatycznych), lecz również parajęzy-
kowych (prozodycznych), które poza funkcjami lingwistycznymi (np. składniowymi) 
mogą pełnić również inne, w tym związane z organizacją czy ekspresją wypowiedzi (por. 
Hirschfeld/Stock 2013: 40–41).8 Do najważniejszych parametrów prozodycznych (aku-
styczno-audytywnych) należą: częstotliwość podstawowa F0 (wysokość dźwięku), inten-
sywność/głośność dźwięku oraz czas trwania/długość dźwięku (por. Selting 1995: 1).9 Do 
tego dochodzą inne zjawiska o charakterze prozodycznym: tempo mowy, rytm, pauzy. 
Wszystkie wymienione wyżej fenomeny w naturalnej mowie ze sobą współwystępują 

 8 Środki niewerbalne (w tym mimika, gesty, postawa ciała) również stanowią ważny środek 
komunikacji, jednak ich analiza nie stanowi przedmiotu niniejszego opracowania. 

 9 Szczegółowy opis najważniejszych parametrów prozodycznych znajduje się w podpunktach 
3.1, 3.2 i 3.3.
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i mogą wzajemnie na siebie oddziaływać (np. szybsze tempo mówienia i głośniejsze 
mówienie). Opis tego typu zjawisk odbywa się zawsze poprzez porównanie wartości da-
nego parametru z wartością parametru z nim sąsiadującego z uwzględnieniem kontekstu 
językowego i pozajęzykowego, w jakim osadzona jest dana realizacja.10 Tak rozumianą 
analizę akustyczną mowy (w tym pomiar i grafi czną wizualizację środków prozodycz-
nych) umożliwia program Praat, który został stworzony przez Paula Boersmę i Davi  da 
Weeninka z Instytutu Nauk Fonetycznych Uniwersytetu Amsterdamskiego. Praat oferuje 
m.in. analizę spektralną  w postaci wykresu widma amplitudowego sygnału dźwięko-
wego, analizę częstotliwości tonu podstawowego (F0) podawaną w hercach (Hz), ana-
lizę intensywności podawaną w decybelach (dB), analizę długości dźwięku podawaną 
w milisekundach (ms), pomiar wartości formantów oraz analizę (jakości) głosu. Poniżej 
przedstawiono przykładowy widok okna „TextGrid”, na które składają się: oscylogram 
ilustrujący przebieg zmian fali dźwiękowej i długość pauz; spektrogram ukazujący wy-
kres widma amplitudowego sygnału dźwiękowego, na którym oznaczono częstotliwość 
podstawową F0 (niebieska krzywa) i intensywność (żółta krzywa) oraz transkrypcja 
wypowiedzi: dobrze to wobec tego yyy moje pytanie dla pani dotyczy certyfi kacji języka 
polskiego jako obcego, patrz grafi ka 5. 

Grafi ka 5. Widok okna „TextGrid” do wypowiedzi dobrze to wobec tego yyy moje pytanie dla pani 
dotyczy certyfi kacji języka polskiego jako obcego

 10 Więcej na temat cech prozodycznych i ich funkcji komunikacyjnych patrz Günther (1999: 
22 ff .),   Auer/Selting (2001: 1123), Fiehler/Barden/Elstermann/Kraft  (2004: 346–349), Lemke 
(2012: 125–127), Schwitalla (2012: 56), Hirschfeld/Stock (2013: 38–41), Imo/Lanwer (2019: 196).
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3.1 Wysokość dźwięku / częstotliwość podstawowa (F0)

Najważniejszym parametrem percepcyjno-słuchowym na poziomie wypowiedzi jest 
wysokość dźwięku (intonacja). Jej akustycznym odpowiednikiem jest częstotliwość 
podstawowa (F0), która określa częstotliwość drgań fałdów głosowych na sekundę 
(por. Kranich 2003: 19, Gilles 2005: 3, Pompino-Marschall 2009: 246). Zmiany w ob-
rębie konturów intonacyjnych (kadencja, antykadencja i progrediencja) służą przede 
wszystkim do oznaczania relacji ważności (akcentowania) i do dzielenia wypowiedzi 
na jednostki znaczeniowe (frazowania). Poniższa grafi ka (grafi ka 6) ukazuje przebieg 
zmian częstotliwości podstawowej (ang. pitch) wypowiedzi: dobrze to wobec tego yyy 
moje pytanie dla pani dotyczy certyfi kacji języka polskiego jako obcego. W tym frag-
mencie wypowiedzi na szczególną uwagę zasługują trzy cechy związane z intonacją, 
które znajdują potwierdzenie w danych akustycznych i widoczne są na wykresie: 
(1) wyraźnie opadająca intonacja wyrazu dobrze, który sygnalizuje początek wypo-
wiedzi i równocześnie początek egzaminu – spadek częstotliwości podstawowej z ok. 
209 Hz do ok. 148 Hz (w transkrypcji oznaczona średnikiem); (2) akcent fokusowy 
sylaby akcentowanej wyrazu moje dla podkreślenia indywidualnego trybu zadawania 
pytań członków komisji egzaminacyjnej – nagły wzrost F0 do ok. 286 Hz (w transkryp-
cji oznaczony dużymi literami); (3) rosnąca intonacja wyrazu obcego, która wskazuje 
na chęć kontynuacji wypowiedzi – wzrost z ok. 204 Hz do ok. 266 Hz (w transkrypcji 
oznaczona przecinkiem), czego dowodzi dalsza część wypowiedzi egzaminatorki11.

Grafi ka 6. Widok okna „Pitch” ukazujący wykres zmian w obrębie częstotliwości 
podstawowej (F0) wypowiedzi dobrze to wobec tego yyy moje pytanie dla pani 

dotyczy certyfi kacji języka polskiego jako obcego

 11 Dalsza część wypowiedzi brzmi następująco: proszę scharakteryzować certyfi kację i powie-
dzieć wszystko co pani na ten temat wie. Jest ona zakończona wyraźnie opadającą intonacją 
i pauzą, co jednoznacznie wskazuje na koniec tej jednostki językowej, por. grafi kę 1.
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3.2 Długość dźwięku / czas trwania

Długość dźwięku jest kolejnym po wysokości parametrem prozodycznym, który od-
grywa ważną rolę w percepcji sygnału dźwiękowego. Jego akustycznym korelatem jest 
czas trwania (ang. duration), który jest fi zycznie mierzalną zmienną i można go okre-
ślić w wartościach bezwzględnych (por. Grassegger 2010: 72). Poniżej przedstawiono 
podział na sylaby wyrazu tego. W analizie audytywnej stwierdzono wydłużenie samo-
głoski [ɔ], które zinterpretowano jako sygnał odwlekający ze względu na następującą 
bezpośrednio po nim pauzę wypełnioną (yyy) oraz składnię wyrażania dobrze to wobec 
tego yyy moje pytanie dla pani dotyczy certyfi kacji języka polskiego jako obcego. Analiza 
spektralna wykazała, że artykulacja wygłosowego [ɔ] trwa powyżej 0.2 sekundy, co 
zgodnie z konwencjami GAT 2 zostało zaznaczone w transkrypcji w postaci dwukrop-
ka, patrz grafi ka 7. 

Grafi ka 7. Widok okna „TextGrid” wyrazu tego z widocznymi parametrami czasowymi

3.3 Głośność / intensywność

Głośność dźwięku jest wielkością postrzeganą subiektywnie. Jej akustycznym od-
powiednikiem jest zaś intensywność (ang. intensity), która opisuje energię dźwięku 
(por. Pétursson/Neppert 2002: 125 ff ., Pompino-Marschall 2009: 153, Lemke 2012: 
138). Na poziomie wypowiedzi w hierarchii parametrów prozodycznych mających 
wpływ na oznaczanie i odbieranie elementów komunikacyjnie ważniejszych od innych 
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najmniejsze znaczenie przypisywane jest właśnie głośności.12 Potwierdza to wykres 
intensywności wypowiedzi dobrze to wobec tego yyy moje pytanie dla pani dotyczy 
certyfi kacji języka polskiego jako obcego, z którego wynika, że jej początek (dobrze to 
wobec tego) wyartykułowany został nieco ciszej (średnia intensywność wynosi ok. 67 
dB) w porównaniu do reszty wypowiedzi (średnia intensywność frazy moje pytanie dla 
pani dotyczy certyfi kacji języka polskiego jako obcego wynosi ok. 72 dB). Warto również 
zwrócić uwagę na fakt, że wyraźna zmiana wysokości tonu w wyrazie moje, o którym 
mowa była w podpunkcie 3.1, nie koreluje ze zmianą intensywności, por. grafi kę 8 
z zaznaczoną realizacją wyrazu moje.13

Grafi ka 8. Widok okna „Intensity” wypowiedzi dobrze to wobec tego yyy moje pytanie dla pani 
dotyczy certyfi kacji języka polskiego jako obcego z zaznaczoną intensywnością wyrazu moje

4. Podsumowanie 

Ustna (prymarna) forma komunikacji, którą charakteryzują spontaniczność, bezpo-
średniość i ulotność, różni się od formy pisanej (sekundarnej) i tym samym wymaga 
zastosowania innych kryteriów opisu i metod badawczych. Badając język mówiony nie 
mamy bowiem do czynienia z gotowym produktem (jak w przypadku tekstów pisa-
nych), lecz z procesem o charakterze interakcyjnym, który podlega swoistym czynni-
kom sytuacyjnym (relacja między nadawcą a odbiorcą, czas, miejsce, cel komunikacji). 
Analiza pełnego spektrum języka mówionego wymaga użycia metod, które pozwalają 

 12 Por. http://www.gtobi.uni-koeln.de/x_grundlagen_prosodie.html#lautstärke, dostęp 
9.8.2024.

 13 W wykresie przedstawiającym intensywność nie ma możliwości dodania transkrypcji. Po-
równanie obu krzywych zostało przedstawione w grafi ce 5. 
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utrwalić zachodzący akt komunikacji, a następnie przeanalizować jego poszczególne 
komponenty (werbalne, parawerbalne i ewentualnie niewerbalne). Program EXMA-
RaLDA sprawdzi się przede wszystkim w analizach audytywnych, gdyż pozwala zacho-
wać i odpowiednio zapisać warstwę brzmieniową nawet bardzo długich wypowiedzi 
(narzędzie Partitur Editor), wyszukać i zgłębić wybrane zjawiska (narzędzie EXAKT) 
oraz tworzyć korpusy tekstów i nimi zarządzać (narzędzie Corpus Manager). Do prze-
prowadzania analiz akustycznych posłuży Praat, który umożliwi przeprowadzenie 
szczegółowej analizy właściwości fi zycznych mowy, w tym analizy częstotliwości pod-
stawowej (opcja „Pitch”), intensywności dźwięku (opcja „Intensity”), analizy widmowej 
(opcja „Spectrum”), analizy formantów (opcja „Formant”) czy analizy jakości głosu 
(opcja „Pulses”). W zależności od przedmiotu badań obie metody (analizę wrażeń słu-
chowych i analizę właściwości fi zycznych mowy) można stosować niezależnie od siebie 
lub paralelnie, uzupełniając wyniki analizy audytywnej opisem danych akustycznych, 
czy też konfrontując dane będące wynikiem (subiektywnej) percepcji słuchowej z da-
nymi liczbowymi będącymi efektem (obiektywnego) pomiaru fali dźwiękowej. Materiał 
badawczy pozyskany w ten sposób może się przyczynić do bardziej wnikliwej analizy 
danych językowych i znaleźć zastosowanie nie tylko w badaniach nad językiem i sze-
roko pojętą komunikacją (np. w fonetyce, pragmatyce czy dialektologii), lecz również 
w badaniach interdyscyplinarnych łączących różne dyscypliny i podejścia badawcze 
(np. w socjolingwistyce, psycholingwistyce czy logopedii). 
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Ścieżki dostępu do funkcji omawianych w artykule

EXMARaLDA

Dodawanie pliku audio: Transkription → Recordings → Add → OK.
Dodawanie mówców: Transkription → Speakertable → Add speaker → OK.
Dodawanie linii werbalnej: Tier → Add tier (Type: Transkription, Category: v) → OK.
Dodawanie linii z komentarzem: Tier → Add tier (Type: Description, Category: k) → OK.
Wyznaczanie segmentów: Append interval → ręczne wyznaczenie granicy końcowej → wpro-

wadzenie transkrypcji → Spacja → Enter.
Wyszukiwanie wybranych zjawisk językowych: Edit → EXAKT search.
Eksport transkrypcji do pliku tekstowego: File → Output.
Eksport transkrypcji do innych aplikacji, w tym np. do Praata: File → Export.

Praat

Dodawanie pliku audio: Open → Read from fi le → View & Edit. 
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Dodawanie do pliku audio transkrypcji: Annotate → To TextGrid → OK.
Łączenie pliku Sound i TextGrid: nacisnąć i przytrzymać klawisz CTRL, a następnie kliknąć 

na każdy z plików → View & Edit.
Analiza spektralna zaznaczonego fragmentu: Spectrum → Show spectrogram → Paint visible 

spectrogram. 
Analiza częstotliwości podstawowej zaznaczonego fragmentu: Pitch → Show pitch → Drew 

visible pitch contour.
Przydatne funkcje w opcji „Pitch”: Get pitch (oblicza średnią częstotliwość podstawową w za-

znaczonym fragmencie), Get minimum pitch (oblicza minimalną częstotliwość podstawo-
wą w zaznaczonym fragmencie), Get maximum pitch (oblicza maksymalną częstotliwość 
podstawową w zaznaczonym fragmencie).

Analiza intensywności zaznaczonego fragmentu: Intensity → Show intensity → Drew visible 
pitch contour.

Przydatne funkcje w opcji „Intensity”: Get intensity (oblicza średnią intensywność w zaznaczo-
nym fragmencie), Get minimum intensity (oblicza minimalną intensywność w zaznaczonym 
fragmencie), Get maximum intensity (oblicza maksymalną intensywność w zaznaczonym 
fragmencie).

Konwencje transkrypcyjne GAT 2 występujące w artykule
(.)   mikropauza o czasie trwania do 0.2 sekundy
(0.7)  pauza pusta trwająca ok. 0.7 sekundy
yyy pauza wypełniona
mhm, hm, hm_hm sygnał recepcyjny (potwierdzający, zaprzeczający, neutralny)
((śmiech)) zdarzenia niewerbalne
tego:  wydłużenie samogłoski [ɔ] o ok. 0.2–0.5 sekundy 
MOje akcent fokusowy na sylabę mo w wyrazie moje
dobrze; intonacja opadająca w wyrazie dobrze
obcego, intonacja rosnąca w wyrazie obcego 
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